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The Thyroid Gland

Anatomy

Two lateral lobes, anterior to the
trachea weight, 10-20g.

Consists of follicles, contain colloid.
Follicles synthesize thyroglobulin.

Thyroglobulin — lumen, synthesis
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(a) The thyroid gland is a butterfly-
shaped gland, located just
below the larynx.

(b) Section of thyroid gland

Thyroid <
follicle

‘/
v A Capsule of
connective
tissue

C cells secrete
calcitonin.

Follicular cells secrete Colloid is a
thyroid hormone. glycoprotein.
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Thyroid Hormone Synthesis and Secretion

Hormone Synthesis

1.

o O B~ W

Active transport of |- into thyroid cells
(1odide trapping).

lodide oxidation and iodination of
tyrosine in Tqg.

Couplingto T, and T,

Tg proteolysis.

Deiodination of iodotyrosines.
Intrathyroidal 5°- delodinase T,— T,
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Synthesis and secretion of T, and T,

(1) lodide trapping
(2) Synthesis of thyroglobulin (TGB)
(3) Oxidation of iodide
Catalysed by peroxidase enzyme
(4) lodination of tyrosine
1-2 1odine 1ons bind to tyrosine to
form MIT (T,) or DIT (T,)
(5) Couplingof T, and T,
2 X DIT molecules join to form T,
1 x MIT + 1 x DIT join to form T,
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Synthesis and secretion of T, and T,

Follicle lumen

Peroxidase

MIT” I\DIT
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‘ TG I |
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Synthesis and secretion of T, and T,

Thyroid follicle cell

Capillary Thyroglobulin is synthesized :
and discharged into the folliclle lumen \ o LOffold

Golgi Colloid in lumen of follicle

apparatus
PP @ lodine enters follicle

lumen where it is attached
to tyrosine in colloid,
forming DIT and MIT

Trapping Oxidation Active form |

active uptake of iodine
E)f iodidep(l') ) /DIT (T2) MIT (T+)

Thyroglobulin
| colloid

T4 @lodinated tyrosines are
linked together to form
Tzand T4

T3 T4 Lysosome

—Ta ' ‘ —T13

e

T
3 ) @Thyroglobulin colloid
is endocytosed and

Lysosomal enzymes cleave 71, T combined with a
y ' T4 and T3 from thyroglobulin lysosome
To peripheral colloid and hormones diffuse
tissues from follicle cell into bloodstream




SYNTHESIS OF THYROID HORMONES: STEP- 2 COUPLING OF IODOTYROSINES

HO
H /Tyr \ CH2C|‘I|COOH + H /Tyr \ CH2|CHCOOH
NH2

NH2

3,5,3’5’-tetraiodothyronine

3,5,3’-Triiodothyronine

Tyf CHzCHCOOH + CH2CHCOOH

HO 0
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STEP 3
DEIODINATION

O CHZTHCOOH
- NH2

“DEACTIVATION” PATHWAY “ACTIVATION” PATHWAY

5-deiodination 5’- deiodination

~ N\
rT3

O CH2CHCOOH O CHZTHCOOH ‘

- NH2 NH?2

3,3’,5’-Triiodothyronine (reverse T3) 3,5,3'-Triiodothyronine (T3)



Thyroxine and Its precursors: Structure &

Synthesis
Tyrosine Thyroxine (Ty)
1
HH o I I HH o
|| |
Ho-)-c-c-c h > HOQO‘DC—C—C//
1 Non L L 0l
H NH, I I H NH,

(2 tyrosine + 41 )

Tyrosine Triiodothyronine (T3)
I
H H
0
o
Ho-5)0-0-C( \ > HO-@- Dc C- c
H NH, OH H NH2 oK

(2 tyrosine + 31)




Dietary lodine

»Food, coastal area
» Thyroid traps 1odide
»RDA: 150 ug - adults
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Thyroglobulin

Large glycoprotein, MW 660,000,
Dimer.

Four tyrosyl sites for hormogenesis on
Thyroglobulin (Tg).
TSH 1, T,] Tg gene.

MRNA — RER — Golqgi
(glycosylation) exocytotic vesicles.

Release Tg into the follicular lumen. .,
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lodide Trap (lodide transport)

Na*/l- symporter (NIS), intrinsic membrane
protein, basement membrane.

Apical surface: pendrin carries I- — colloid
TSH 1 NIS

TSH receptor stimulated antibody (Grave’s
disease) T NIS

Perchlorate (CIO,), SCN-, NO; | NIS
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Thyroid Peroxidase

Membrane — bound glycoprotein
MW 102,000 (apical cell surface)
Oxidation of 1odide 1ons by H,O..

NADPH: generation of H,O.,.
lodination of tyr on Tg.

RER — Golgl — exocytotic
vesicles to apical cell surface.

TSH 1 thyroidal peroxidase. .



Thyroperoxidase

» lodination of Tyrosines in Thyroglobulin
(H,0,) generated by NADPH

» Coupling of lodotyrosines
Dimeric structure of Tg Is essential.
DIT +DIT - T,,DIT + MIT — T,

» Thiocarbamide drugs (Polythiouracil PTU,
carbimazole) — | thyroperoxidase

(treatment of hyperthyroidism).
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Proteolysis of Thyroglobulin

Lysosomal enzymes fused with colloid
vesicles.

Releasing T,, T,, DIT, MIT, peptide
fragments, a.as.

T,/T, released into circulation
(stimulated by TSH).

DIT/MIT delodinated (I- conserved)
Lithium | Tg proteolysis.
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Abnormalities in Thyroid Hormone Synthesis

Inherited metabolic Defects
Dyshormonogenesis (any phase)
Thyroid enlargement — goiter
Mild-severe hypothyroidism

| T,/T,, 1 TSH

Effect of lodide deficiency

Low iodine diet: 1 MIT/DIT, 1 T,/T, ratio
(1 5°- delodinase) , | T, secretion, 1T TSH,
goiter.

Neonate: Cretinism 17




Abnormalities in Thyroid Hormone Synthesis...

Effect of 1odine Excess
» Wolff — Chaikoff Effect: 1 lodide
(diet) Initially torganification up to a
certain level then | organification due to
| Hy0;

» Effect Is transient, normal gland
"escapes* from I" effect
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Thyroid Hormone Transport

T,/T, transport in serum bound to:
1. Thyroxine — binding globulin (TBG) 70%

2. Thyroxine — binding prealbumin (TBPA) or
transthyretin

3. Albumin 15%

Free Hormone "active"
0.04% T,,0.4% T,
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Metabolism of thyroid Hormones

T, 100 nmol/day, T; 5 nmol, rT; <5 nmol

Type 1 (5’ — deiodinase)

In liver, kidney, thyroid, muscle

To provide T, to the plasma

7 1In hyperthyroidism | in hypothyroidism

Inhibited by PTU

Dietary deficiency of Selenium inhibits T, — T,
Type 2 (5’ — deiodinase)

Brain and pituitary, maintain intracellular T; to CNS

Resistant to PTU, sensitiveto T,
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Metabolism of thyroid Hormones ...

Type 3 (5 — delodinase)
Placenta, glial cells

nactivation of T4 and T3
L — I
. — 3,37 -T,

N

" In hyperthyroidism (protects fetus and
brain from 1 or | T4)
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Function of Delodinases

> Local Tissue and cellular control of
thyroid activity

» Adapt to environment such as state of |-
deficiency
» 80% of T, metabolized by delodination:

35% to T;, 45% torT,
Half — Life
T, 7 days, T4 1 day, rT5 0.2 day.
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Control of Thyroid Function

. Hypothalamic — pituitary thyroid axis

TRH — 1 TSH — 1 thyroid gland growth
and hormone secretion

. Delodinases T, — T,

. lodine supply

. TSH — receptor autoantibodies
( Agonists, Antagonists)
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Thyrotropin — Releasing Hormone -TRH

» TRH binds to thyrotrophs and Lactotrophs 1 TSH
and PRL

» T, | TRH receptor, E, 1 TRH receptors and
sensitivity.

» TRH: release of stored TSH, 1 hormone synthesis.

» THR receptor: seven—transmembrane — GTP

1 phospholipase C IP; — 1 Release

11,2 DAG — PKC — 1 hormone synthesis

» TRH 1 glycosylation of TSH (full biological
activity) y




Control of Thyroid Function:

Effectof T

» T, directly inhibits TRH gene
transcription.

» T, | TRH synthesis and release
(through T,)
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TSH secretion

Circadian rhythm, pulsatile
(nocturnal surge)

Cold (animals and newborn only): 1
TRH, TSH (not In adults).

T,, T,, a-adrenergic agonists,
ADH — 1 TRH.
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TSH: Effects

» Accelerates Tg resorption, 1
lysosomal formation — Tg hydrolysis

» Cell growth — thyroid enlargement
» 1 All phases of I- metabolism:

T I uptake, transport, 1odination
of Tg — secretion of T,/T,.

CAMP — 1 | transport
IP,, Ca** — lodination of Tg.
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TSH: Effects ...

T MRNA for Tg and thyroperoxidase.
T Type 1 5°- delodinase.

Glucose uptake, O, consumption,
glucose oxidation via HMP
(NADPH) and krebs cycle (ATP).
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TSH Secretion

» Intrathyrotroph T, controls TSH
MRNA, TSH release

» TRH: glycosylation, activation
and release of TSH

» Somatostatin, dopamine,
(bromocriptine), Glucocorticolds:

| TSH
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The Actions of Thyroid Hormones:

1. Thyroid Hormone Receptor

> Structure

 Within the cell T, — T, by
5’- delodinase.

» Receptor family: T, glucocorticoids,
mineralocorticoids, estrogens,
progestins, vitamin D, retinoic acid,
retrovirus v-erb A.
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The Actions of Thyroid Hormones:

1. Thyroid Hormone Receptor ...

> TR Gene
 Twogenes: aand B (TR al & 2; TR B1 & 2).
TR a2: does not bind T, Inhibits T, action.
* Thyroid receptor: three domains:
N-terminal (ligand-independent).
DNA binding: two cysteine — Zn “fingers”.
C-terminal (ligand binding).
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The Actions of Thyroid Hormones:

1. Thyroid Hormone Receptor ...
DNA binding

 Thyroid hormone receptors (TR) bind to
specific thyroid hormone response
element (TRE) sites on DNA.

* Form heterodimers: with retinoid x
receptor (RxR) or retinoic acid receptor
(RAR).

» |n absence of T, corepressors suppress
gene. >



The Actions of Thyroid Hormones:

1. Thyroid Hormone Receptor ...

T, binding

« Disruption of TR homodimers or
heterodimers on TRE.

* Displacement of corepressors.

* Binding of coactivators.

 Activates gene transcription.
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Physiologic Effect of Thyroid

Hormones

» (Genomic actions: tissue growth,
brain maturation, 1 heat production
and O, consumption due to 1 Na*-K*
ATPase and 1 B-adrenergic receptors.

» Non-genomic Action: | pituitary
type 2 5°- delodinase 1 glucose and
amino acid transport.
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1.

Physiologic Effect of Thyroid

Hormones...

Effect on Fetal Development:

* Thyroid In fetus begins 11 wks,
T,/T, secretion 18-20 wks.

 Placental type 3 5-deiodinase —
Inactivation of most T,/T,.

» | fetal T5: cretinism (mental
retardation and dwarfism).
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Physiologic Effect of Thyroid

Hormones...
2. Effect on O, consumption and Heat Production

* Due to 1 Na*™— K* ATPase except In brain,
spleen, testis

3. Cardiovascular Effects
* 1 myosin heavy chain o Improving cardiac
output
» 1 Ca** ATPase In sarcoplasmic reticulum
1 3 adrenergic receptors.

1 Cardiac output, heart rate in hyperthyroieism




Physiologic Effect of Thyroid

Hormones...

4. Sympathetic Effects

* T; 1 B-adrenergic receptors in heart, skeletal,
adipose tissue.

* Sensitivity to catecholamine 1 in hyperthyroidism

» [-adrenergic blockers controls tachycardia and
arrhythmias.

5. Hematopoletic Effects
« T, 1 erythropoietin — erythropoiesis.
« 12,3- DPG 1 O, dissociation from Hb.
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Physiologic Effect of Thyroid

Hormones...

6. G.l. Effects
» T3 1 gut motility, diarrhea.

» (Hyperthyroidism) — weight loss
» (Hypothyroidism) — weight gain
/. Skeletal Effects
» T5 7 bone turnover, 1 bone resorption,

» Hyperthyroidism — osteopenia,
hypercalcemia, hypercalciuria.
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Physiologic Effect of Thyroid Hormones...

. Neuromuscular Effects

» Hyperthyroidism: 1 protein turnover, myopathy,
hyperflexia

» T,: CNS development + function
» Adults: hypothyroidism — sluggishness

. Endocrine Effect
» T; 1 cortisol turnover; 1 Rate of cortisol production.

» Ovulation impaired in hypo- and hyperthyroidism
(infertility).
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Physiologic Effect of Thyroid

Hormones...

10. Effects on Lipids and Carbohydrates

» T, 1 hepatic gluconeogenesis,
glycogenolysis, 1G.1. Glucose absorption
(exacerbate diabetes mellitus).

» 1Cholesterol synthesis and degradation
(1LDL receptors) —| chol.

» 1 lipolysis
» Hypothyroidism: 1 chol. levels "



Tests of Thyroid Function

1. Thyroid Hormones in Blood

» Total T,/T,, Free T,/T,, rT5, Tg
(metastasis)

» Free T, (FT,) estimated using FT,
Index (FT,I)
» FT, doesn't measure T, (early

Graves' disease, T, toxicosis), FT,
low, hyperthyroid state.
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Tests of Thyroid Function ...

2. Hypothalamic —Pituitary — Thyroid AXIs

>
>
>

YV VYV

Serum TSH: (TRH = not clinically feasible)
FT4 a 1/log TSH

TSH pituitary tumors: FT4 1, FSH not
suppressed
Hypothyroidism: 1 TSH, |FT4.

Hypothyroidism (pituitary or hypothalamic
tumor): FT4 |, TSH not elevated, no TSH
response to TRH.
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Tests of Thyroid Function ...

Serum TSH

Most sensitive convenient,
specific test for hypothyroidism,
and hyperthyroidism.



Tests of Thyroid Function ...

Cardiac muscle contractility
» Time QRS complex to opening of aortic value.

>
>

_eft ventricular ejection time (LVET).
Prolonged In hypothyroidism, shortened in

nyperthyroidism.

Thyroid Autoantibodies.
» Thyroglobulin antibody (Tg Ab)

>

Thyroperoxidase antibody (TPO Ab)

» TSH receptor antibody (TSH-R Ab [stim] or [block])
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Disorders of the Thyroid

Patients usually complain of:

1.
2. T
3.

4. Complications of a specific form of

T

T

NYIoIC
NYIoIC

NYIoiC

enlargement (diffuse or nodular)
deficiency (hypothyroidism)
hormone excess (hyperthyroidism)

hyperthyroidism: Graves' disease (with
exophthalmos) and thickening of the skin over
the lower legs (thyroid dermopathy)
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Hypothyroidism

. primary (thyroid failure).

. Secondary (due to pituitary TSH
deficit).

. Tertiary (due to hypothalamic TRH
deficiency).

. Peripheral Resistance (to the action
of thyroid hormone).
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Hypothyroidism ...

=i i[o][0]s)Y,

1.

L

Hashimoto's thyroiditis (autoimmune
thyroiditis) with or without goiter. In older
patients: gland destroyed by thyroperoxidase
autoantibodies.

Radioactive 1odine therapy for Graves' disease.
lodine deficiency (developing countries).
Excessive iodide intake.

Drugs: Lithium carbonate (depression), PTU.
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Hypothyroidism ...

Pathogenesis
» Accumulation of glycosaminoglycans.
» 1 hyaluronic acid in interstitial tissues.
> 1 Capillary permeability to albumin.

» Interstitial edema (skin, heart muscle,
striated muscle).
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Hypothyroidism ...

Clinical Presentations

» (Goiter, mental retardation, short stature, puffy
face and hands, deaf.

> Due to:

« Failure of thyroid to descend.

* Placental transfer of TSH-R Ab [block] from
mother with Hashimoto’s thyroiditis.

* Inherited defects of T,/T, biosynthesis.

» Serum T, <6 pg/dL or TSH > 25 puU/ml =
neonatal hypothyroidism. *
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Hypothyroidism ...

Clinical Presentations ....

» Retarded growth, mental
retardation, obesity

» In adolescence: precocious
puberty, short stature
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Hypothyroidism ...

Clinical Presentations ....

» Easy fatigability, coldness, weight gain, constipation,
menstrual irregularities, and muscle cramps.

» Physical finings: cool, rough, dry skin; puffy face and
hands; slow reflexes.
1. Cardiovascular signs
2. Pulmonary function
3. Intestinal peristalsis
4. Renal function
5. Anemia: | Hb synthesis; Fe, Folate, B,, deficiency
6. Neuromuscular system
7. CNS symptoms 52



Hypothyroidism ...

Complications

» End stage of untreated hypothyroidism.

» Progressive weakness, hypothermia,
hypoventilation, hypoglycemia, water
Intoxication, shock and death.

» Depression, confusion, paranoid.
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Diagnosis of Hypothyroidism

Patient takes Patient takes no
thyroid hormone thyroid hormone
Stop medication > Serum FT, and
6 weeks serum TSH
FT, normal FT, low, FT,4 low,
TSH normal TSH high TSH normal or low
! ! '
v
EUTHYROID PRIMARY SECONDARY
HYPOTHYROIDISM - _ HYPOTHYROIDISM
1 i
equ/lVOC\\ ¢
Q) TRH test
Excessive/ Normal type \ No
response response response
PRIMARY HYPOTHALAMIC PITUITARY
HYPOTHYROIDISM LESION LESION

Figure 7-36. Diagnosis of hypothyroidism. Either free thyroxine (FT,) or free thyroxine index
(FT4I) may be used with TSH for evaluation.




Hyperthyroidism and

Thyrotoxicosis

Thyrotoxicosis:

Clinical syndrome when tissues are
exposed to high levels of thyroid
hormones.
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Graves’ Disease

Diffuse Toxic Goiter

Features
» ThyrotoxIcosis.
» (Golter.
» Ophthalmopathy (exophthalmos).
» Dermopathy (peritibial myxedema).
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Graves’ Disease ...

=i i[o][e]s)Y,
» Autoimmune disease.
» Antibodies against TSH receptors.

» Antibodies have the capacity to stimulate.
thyroid gland (growth and function).

» Antibodies: TSH-R Ab [stim].
» Genetic predisposition.
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Graves’ Disease ...

Exophthalmos

» Cytotoxic lymphocytes (killer cells) and
cytotoxic antibodies sensitized to a
common antigen as TSH-R In orbital
fibroblasts, orbital muscles, and thyroid
tissues.

> Inflammation of orbital fibroblasts, swollen
orbital muscles, periorbital edema.
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Graves’ Disease ...




Graves’ Disease ...

Thyroid Dermopathy

» Thickening of the skin (particularly
over lower tibia).

» Accumulation of glycosaminoglycans.
Thyroid Osteopathy

» Bone swelling

» Separation of fingernails
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Relationship between free T4 and TSH

A 1000 —
E Levothyroxine suppressed (euthyroid) (n = 20)
_ A Hypothyroid (primary) (n = 49)
= m Euthyroid (n = 194)
100 — OO Hyperthyroid (nonpituitary) (n = 56)
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Figure 7—28. A: Relationship between serum free thyroxine by dialysis (FT,)
ng/dL and log,, TSH in euthyroid, hyperthyroid, hypothyroid, and L-T,-suppressed
euthyroid individuals. Note that for each unit change in T, there is a logarithmic
change in TSH.




